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HotFind is an application designed to expand on the features 
of Hotline.  HotFind’s main functions are to search for files 
on Hotline servers, and to manage and retrieve tracker lists.  
This manual will explain in detail the full extent of HotFind, 
so you can get the most out of the program.

Throughout this manual, bold, green text will be used to 
denote names of windows, menus, buttons, tabs or other 
parts of HotFind.  Bold, blue text is used for keystroke 
commands.  Italicized text indicates steps to follow.  Bold  text 
will be used to denote sections of this manual.
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Quick Start 1. Open HotFind.

When you open up HotFind, you will be presented with the 
registration window.  This window allows you to enter your 
registration number if you have paid for HotFind, and helps 
you with your registration if you have not already done so.  
You are allowed to try out HotFind for up to 30 days 
without paying.  However, in this demo mode, the 
registration window will always pop up when you launch 
Hotfind until you register, and the functions of HotFind will 
be severely limited.  These limitations will be described in 
detail later, once you get to know the program.

2. a. Click Not Yet to continue to try out HotFind without a 
registration number.

b. Click Personalize to enter your registration number and 
unlock the full features of HotFind.

c. Click Launch Register to launch the registration 
application that will allow you to send in your registration 
form for HotFind.

d. Click Register Online to go to the online website where 
you can register HotFind.

3. Go through the Setup Wizard.

The Setup Wizard goes through the most important 
preferences in HotFind.  The first window allows you to set 
your name and your icon, which appear in the user list of a 
Hotline server when you use HotFind.  The second window 
allows you to change the maximum number of 
simultaneous connections to Hotline servers HotFind 
makes.  16 is the default, but if your internet connection is 
fast enough, you may want to increase this number to make 
indexing in HotFind faster.  The last window prompts you 
for proxy settings.  Proxy settings are usually only on 
networks at businesses, and people behind proxies cannot 
access the internet unless the proxy address and port are 
known.  The other preferences are described in the 
Preferences section of this manual.

a. Set your desired nickname and icon in the first window.
b. Set the number of connections you want HotFind to make 

in the second window.
c. Enter your proxy settings in the third window.  If you are 

not sure whether you are behind a proxy or not, do not 
enter settings for the proxy.
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4. Read the quick start.

After you have gone through the Setup Wizard, HotFind 
will present to you a quick start, much like this one.  The 
other two tabs in the same window present you with the 
meaning of icons in the server list, and quick tips for making 
your use of HotFind easier.  This quick start can be 
reaccessed if needed from the Help menu.

5. Load the server list.

The window that is presented to you after dismissing the 
Quick Start is the All Hotline Servers window.  This 
window will show the list of all servers that are listed on all 
known public Hotline trackers, except the ones you have 
filtered out.  HotFind automatically updates its list of 
trackers using the website at www.tracker-tracker.com, so 
you don’t have to worry about the addresses of each and 
every tracker.  To load the server list, press the Refresh 
button at the top of the window, or press Cmd-R.  In the top 
right-hand corner, there will be two moving arrows 
indicating that the server list is being retrieved.  Wait until 
the arrows go away so you know that the entire list of 
servers has been retrieved.  To interrupt this process, you 
can press the Stop button.

6. Filter out the servers using the description search.

Below the buttons, there is a field called the Description 
Search field.  This field allows you to narrow down the list of 
servers, so indexing of the servers will not take as long.  To 
filter the servers, type in a search string, and only the 
servers that match your search criteria will appear in the list.  
The description search will be described in much detail in the 
The All Hotline Servers window section of this manual.
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7. Index the servers.

Once you have filtered out the servers, you can begin 
indexing.  Indexing is the process where HotFind logs on to 
one of the servers on the list, and retrieves the list of files 
from that server.  HotFind can log on to multiple servers at 
a time, up to the maximum that has been set in the 
preferences.  To index servers, select part of the list of 
servers, or select all of them, and press the index button at 
the top of the window.  You can also press Cmd-I.  The 
Indexing window shows two chasing arrows to indicate that 
indexing is in progress.  When the arrows disappear, 
indexing is finished.

8. Find the files you are looking for.

After indexing, you are ready to find files.  Finding files is 
simple: click the Find File button at the top of the window 
or press Cmd-F, type in a name and select a type of file, and 
press the Find button.  HotFind will find all files that match 
your search criteria, and will display the results in the Items 
Found window.

9. Connect to the server that has your desired file, and download 
or view the file, or download it automatically via Pitbull.

In the Items Found window, select the file that you think 
closely matches the one you are looking for.  Then, click the 
Connect button at the top of the Items Found window, or 
press Cmd-K.  HotFind will automatically connect you to the 
server that has the file on it using the Hotline client or a 
Hotline clone, and you can begin downloading the file.

Pressing the Download button instead will launch Pitbull (a 
download only Hotline client available at www.tracker-
tracker.com/pitbull), automatically connect to the server, 
and start downloading the file.
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Preferences 1. Click the Preferences button at the top of the All Hotline 
Servers window, or select Preferences... from the Edit menu.

The preferences dialog is where settings for various 
functions throughout HotFind can be set.  Preferences 
control how HotFind behaves, and some preferences should 
be set differently for people with different internet 
connections.

2. Change your identity settings.

The identity settings tell HotFind how to identify you when 
you connect to servers through HotFind, and you should 
have already changed these preferences through the Setup 
Wizard.  Your name will appear in the user list of the server, 
along with the icon you specify.  Although you cannot see 
them directly through HotFind, other users connected to the 
server using a regular Hotline client can see your name and 
the icon you are using.

a. Specify a name to identify yourself.
b. Scroll through the list of icons and choose one, or choose an 

icon ID to jump directly to the desired icon.

The icons that are in the list depend on the icon file that is in 
the HotFind folder.  HotFind comes with a set of icons that is 
similar to the one used by Hotline 1.2.3.

Although it is possible to customize the icon set you have, be 
aware that Hotline servers which HotFind connects to only 
get the icon number.  This means that someone else using a 
different icon list will see a different icon than the one you 
see for yourself, so if you use a custom icon list, many 
people will probably not see the same icon you see.  By 
using the icon set of Hotline 1.2.3, anyone with a Hotline 
client version 1.2.3 or above will see the icon you intended 
them to see.
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3. Specify where your folder of bookmarks is.

The Hotline client and Hotline clones usually use bookmarks 
to store information about a server, and perhaps account 
login names and passwords.  When you specify where your 
bookmarks folder is, HotFind will automatically add those 
bookmarks to the server list, and any accounts you have in 
those bookmarks will be used when indexing that server.

a. Click the Browse... button.
b. Find your folder of bookmarks.
c. Select the folder, and click the Choose button in the dialog.

4. Specify the startup settings.

The last setting in this part of the preferences is the Load 
cached main server list.  This option tells HotFind to 
automatically load the list of servers in the All Hotline 
Servers window when you start up HotFind.

5. Go to the Layout tab.

At the top of the preferences dialog, you will see four tabs.  
Each one contains different settings that you can specify to 
customize HotFind.  The Layout tab allows you to specify 
settings related to the layout in the All Hotline Servers 
window.

These three settings allow you to enable or disable three 
specific columns in the All Hotline Servers window.  The 
Address column gives you the address of the server, the 
Files column tells you how many files you have indexed 
that are on the server, and the Users column tells you how 
many users were on at the time that HotFind connected to 
that server.  Other columns cannot be disabled, and will 
always appear.

5. Go to the Indexing  tab.

The Indexing tab specifies settings on how HotFind behaves 
when indexing.
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6. Specify the indexing settings.

The Maximum indexing depth setting is the number of 
nested folders that HotFind will browse through to index 
files.  HotFind will stop if it reaches the maximum indexing 
depth.  This is especially useful when servers put little tricks 
in their files, like linking an alias back to the original folder, 
making an infinite loop.

The Maximum number of connections setting tells HotFind 
how many servers to connect to at once when indexing.  
This setting should have been set after going through the 
Setup Wizard.  Any changes to the number of connections 
will require you to restart HotFind before they take effect.

You can also specify the type of indexing HotFind does.  
Index all servers tells HotFind to index any and all servers 
that were selected to be indexed.  With the Only index 
servers with “Guest Download” setting selected, Hotfind 
will check if guests are allowed to download from a server, 
index servers that allow guests to download, and skip those 
that do not.  The Don’t index, only check “Guest 
Download” state setting tells HotFind only to check 
whether the server allows guests to download or not.

7. Specify the cache folder settings.

The cache folder is where HotFind stores the list of files that 
are on specific servers.  This folder can accumulate more 
than 1000 cache files.   Automatically delete old cache files 
tells HotFind that this cache folder should be periodically 
cleared out.  You can specify after how many days a cache 
file should be purged using the box below this setting.  To 
empty the cache folder manually of all indexes, press the 
Empty Now button.  You can specify where the cache folder 
is by clicking the Browse... button and locating the folder.

8. Go to the Filtering tab.

The Filtering tab tells HotFind what words to filter out 
when refreshing the server list.
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9.  Specify filter settings.

The first field deals with the tracker addresses themselves.  
To ignore trackers that have a certain word in them, click the 
first checkbox, and list all the words you want to have 
ignored, separating each word with commas.  The second 
field is exactly like the first field, except it filters out words in 
the name and description of servers instead.

10. Go to the Advanced tab.

The Advanced tab deals with other very specific settings 
with HotFind.

11. Specify your proxy settings.

Proxies are usually only on a network for a business, but if 
you know you are behind a proxy, click the checkbox for 
using proxies, and put in the server address and port in the 
respective fields.  If you do not do this and are behind a 
proxy, HotFind may not be able to function.  If you are not 
sure whether you are behind a proxy, do not click the 
checkbox.

12. Select the application you want HotFind to use when 
connecting directly to servers to download files.

As a default, HotFind uses the Hotline client to connect to 
Hotline servers.  However, it can be configured to use one 
of the Hotline clones.  A Hotline clone is an application 
similar to Hotline, using the same connection protocol, but is 
not made by Hotline Communications Ltd.  To specify 
which application you want to use, click the appropriate 
radio button.  If you select Other, click the Select button, 
and browse to find the application.  Then select it, and click 
the Choose button.

13. Specify autoresponse settings.

People on servers cannot distinguish you using HotFind 
from other people using a regular client.  Sometimes, people 
send you a private message.  If you turn this option on, the 
message you supply in the field below will be sent to a 
person that sends you a private message.  This will let 
people know that you are not able to respond or chat with 
them.
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The All Hotline 
Servers Window

The All Hotline Servers window

The All Hotline Servers window is the place where most of 
the functions of HotFind are initiated.  This window can be 
accessed via the Window menu, or by pressing Cmd-0 
(zero).  At the top of the window are eight buttons which 
access the main functions of HotFind.

The Connect button connects to the selected server using a 
Hotline client or clone as specified in the preferences.  If 
multiple copies of the same kind of client are open (only if 
the option Hotline or Hotlyin is selected in the preferences), 
HotFind will present you with a list of the clients open, and 
you can choose the one you want to connect to the server 
with.  This function can also be accessed via the Server 
menu, or by pressing Cmd-K.

The Info button supplies info about the selected server in a 
dialog.  The server name, address, number of users, and 
description can all be seen in the All Hotline Servers 
window if all columns are turned on.  Additionally, the info 
dialog supplies account info.  Here you enter your login and 
password for a specific server, so when HotFind accesses 
that server, it uses your account and not the guest one.  This 
is particularly useful if you want to access a server that is 
locked to guests.  This function can also be accessed via the 
Server menu, by selecting Server Info.
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The Files button brings up the browsing window, where 
you can browse through a server’s file list.  You can find a 
detailed explanation of this window in the Finding Files 
section of this manual.

The Index button tells HotFind to start indexing the server 
according to the type of indexing set in the preferences.  The 
server or set of servers that is selected when pressing this 
button will be added to the Indexing window and will be 
indexed.  If no servers are selected when this button is 
pressed, all servers in the topmost list will be added to the 
Indexing window.  Any partial index of a specific server will 
be deleted if the server is set to be indexed.  Indexing can 
also be initiated through the Server menu, or by pressing 
Cmd-I.

The Find File button allows you to find files in all the 
directories of servers you have indexed, including partially 
indexed servers.  Select the type of name search you want to 
invoke, and enter a word or phrase you want to search for.  
Additionally, you can select a certain type you want to look 
for.  At this time, HotFind can only search for specific types, 
it cannot omit certain types.  You may also specify if you 
want to only search the top list of servers, or if you want to 
search servers with guest download only.  Once you have 
set your search parameters, press Find to tell HotFind to 
start searching.  To abort a search in progress, you can press 
the Stop button.  The Items Found window will appear and 
will display all files or folders meeting your search 
parameters.  This procedure will be described in more detail 
in the section Finding Files.

The Refresh button refreshes the server list, and gets the 
current list of servers from all known trackers at 
www.tracker-tracker.com.  This can be accessed through the 
Server menu, or by pressing Cmd-R.

The Preferences button brings up the dialog to change your 
preferences.  You can access the preferences using the Edit 
menu.
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The Description Search is a very useful function in HotFind, 
but it is also complicated.  The description search is a 
complete Boolean search, and it allows you to filter out the 
servers in a server list.  Each search string is a single Boolean 
expression made up of one or more arguments together 
with any number of Boolean operators.  The simplest search 
is a single word without any operators (i.e.: the search for 
“hotline” will return all servers that have the word “hotline” 
in their name or description).  HotFind supports the 
following Boolean operators:

AND or +:
both the argument preceding and following the AND 
operator or + sign will be required in the name or 
description of the server

NOT or -:
the argument preceding the NOT operator or - sign will be 
required, and the argument after the minus sign will be 
required not to be in the name or description of the server

OR or a space:
either the argument before or the argument following the 
OR operator or the space will be required in the name or 
description of the server, or both can be included

If you are looking for a specific phrase or group of words in 
a specific order, you can put them between quotes “”, so 
they are treated as a single argument.

Simple expressions are evaluated from left to right.  More 
complex Boolean expressions can be formed using 
parentheses.  Any arguments and operators between 
parentheses ( ) will be evaluated first starting with the 
innermost set of parentheses.
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Here are some examples:

hi -private +“erik’s hangout”

This example will return all servers that have “hi”, do 
not have “private”, and have the exact phrase “erik’s 
hangout” in their name or description.

hi -private +(sim server)

This example will return all servers that have “hi”, do 
not have “private”, and have either the word “sim” 
or the word “server” in their name or description.  
Let’s take a closer look at how this expression is dealt 
with.

In this case, the Boolean expression between the 
parentheses (“sim” OR “server”) is evaluated before 
the rest of the expression, so first it is determined if 
the server name or description contains either the 
word “sim” or the word “server”.  The result of this 
evaluation is substituted into the expression giving 
two possible expressions after the substitution:

1. If the word “sim” or the word “server” is in the 
name or description:

hi - private + TRUE

This expression will return true if the word 
“hi” is in the name or description, but not the 
word “private”.

2. If neither the word “sim” nor the word “server” is 
in the name or description:

hi - private + FALSE

This expression will always return false.

hi -“X X X” -(win pc)

This example will return all servers that have “hi”, do 
not have the exact phrase “X X X”, and do not have 
either the word “win” or the word “pc” in their name 
or description (equivalent to: hi - “X X X” -win -pc).
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Below the description search is a listbox.  This is the main 
server list, where you can select servers and do certain 
functions with them.  There are up to six columns in the list 
part of the All Hotline Servers window.  The icon column 
gives you information about the state of the server.  This 
column is the leftmost column, and is not named.  The icons 
column has eight different states of icons: one of them being 
blank to indicate that nothing has been done with this 
server, and seven icons.  The meaning of each icon can be 
retrieved by selecting Status Icons from the Help menu.  
The Name column gives you the name of the server.  The 
Users column gives you the number of users that were on 
the server at the time HotFind retrieved the tracker lists.  
The Address column gives you the address of the server, 
including the port in the address.  The Files column gives 
you the number of files on the server that you have indexed.  
The Description column gives you the description of the 
server as provided by the server’s host.

The window may be too small to show all of these columns.  
If desired, the Address, Files, and Users columns can be 
disabled via the Layout section in the preferences of 
HotFind.

The main server list can be sorted by clicking the title of each 
column.  If there are a lot of servers in the list, it may take a 
few seconds for HotFind to sort them all.
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The Indexing 
Window

The indexing window

The indexing window tells information about servers 
currently being indexed, and can be accessed by pressing 
Cmd-1 (one).

Files Located tells you how many files HotFind has found 
on any server in that session.

Indexing tells you how many servers are currently being 
indexed out of how many servers total will be indexed.

The list in the Indexing window shows the name of each 
server that is going to be indexed.  If a little icon appears 
next to a server, that means it is currently being indexed.  To 
index a server, a list of servers, or a set of selected servers, 
use the Index button on the top of the window of any server 
list.  Any partial index will be deleted and written over.  
Servers that have already been indexed will be skipped if 
you try to reindex them, unless you delete their index file 
first.  You can do this by selecting a server or group of 
servers, and then choosing Delete Index from the Server 
menu, or by pressing Cmd-D.
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Server Lists 1. Create a new server list.

Server lists are a great way to organize lists of servers that 
you want to access frequently.  To create a new server list, 
select New from the File menu, or by pressing Cmd-N.  This 
will create a blank server list, where you can add servers to 
it.  You can also use existing server lists and save them later.

2.  Add servers to your server list.

There are a number of to add servers to your list.  The first 
way and most simplest is to refresh the server list.  This will 
add all servers on all known trackers to your server list.  
When you reload the server list, all servers from your 
bookmark folder will automatically be added also.  Another 
way to add servers to your list is to drag bookmarks from 
the Finder into the server list.  You can also drop folders 
onto the server list, and HotFind will automatically search 
for bookmarks in nestled folders and add them to the server 
list.  You can also drag servers from other server lists onto 
the window.  

3. Add account information to your server list.

Account information is used when connecting to a server.  
Accounts can contain different sets of files, and can even 
simply allow someone access to a server.  The Load 
passwords... function can load account information into a 
server list by importing from a special password file 
containing the login information for a set of servers.  This 
feature is currently used to store and retrieve any account 
information you enter into HotFind so that it will 
“remember” that information when you refresh the server 
list.  Downloadable password files may become available 
from websites and Hotline servers in the future as a means 
of storing multiple accounts in a single file.  Another way is 
to drag bookmarks or folders containing bookmarks, and 
any account information will be transferred along with the 
server information.  Dragging servers with account 
information from other server lists will also preserve 
account information.  Additionally, you can use the Info 
button on the top of the window while selecting a server to 
add logins and passwords.  The same can be achieved by 
invoking the Login/Password... command from the Server 
menu.
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4. Save your server list.

Choose Save, press Cmd-S, or choose Save as... from the 
File menu, and select a name and location for it to be saved.  
If you want to close a server list without saving, select Close 
from the file menu.  When you want to open your saved 
server list again, simply choose Open from the file menu, 
find the saved list, and double click it.

5. Use your server list to find files, or to index, bookmark, or 
connect to specific servers.

You can now use your server list to index or find files.  To 
bookmark a server, simply option double click on a server 
and save the bookmark somewhere, or select Bookmark... 
from the Server menu.
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Finding Files 1. Using a server list, or a selected set of servers, index the 
servers.

Before you can find any file, you must index the servers.  
Select a group of servers or one server, and select the Index 
button.  If no servers are selected, all servers on the topmost 
list will be indexed.  If you want to delete an index or reindex 
a server or group of servers, select a server or group of 
servers, and then select Delete Index from the Server menu, 
or press Cmd-D.  A partial index will be overwritten when 
reindexing the same server.

2. Find files.

When you have finished indexing the servers you want to 
index, select the Find File button.  Enter your search criteria, 
and press Find.  HotFind will bring up a window called 
Items Found in which it will display all files or folders that 
meet your criteria.

The Items Found window
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3.  Find the specific file you are looking for.

In the top section, the Items Found displays all files or 
folders meeting the criteria you specified in the File Search 
dialog.  Scroll through this list to find the file or folder that 
most closely relates to what you are searching for.  To assist 
you in finding the file you want, you can sort the list in the 
Items Found window by clicking the column headers.  Once 
you have found the file you want, select this item.  

After selecting the item you want, notice how a path to the 
file appears in the bottom section of the Items Found 
window.  This is useful when you connect to the Hotline 
server when manually downloading the file, because it tells 
you exactly where the file is on the server.  Each name on 
each separate line tells which folder to open next.  The item 
on the last line is the actual file you are looking for.  You can 
expand either section of the Items Found window by clicking 
and holding on the separator bar between the top and 
bottom lists, and then dragging in the desired direction.

Once you select the file you want, you can also invoke 
different commands similar to the ones the All Hotline 
Servers window can.  The Connect button connects you to 
the server with the selected file or folder on it.  Like the 
connect button in the All Hotline Servers window, if 
multiple copies of the same client are open, HotFind will 
prompt you for the one you want to connect with.  The Info 
button shows you info about the server the selected file is 
on, and allows you to change account settings for that 
server.  The Files button allows you to browse the files of 
the specific server, and the folder enclosing the selected file 
or folder will automatically be shown in the browsing 
window, not the root folder.  The Download button tells 
Pitbull (a download only Hotline client available at 
www.tracker-tracker.com/pitbull) to automatically connect 
to the server and download the file.  The Stop button allows 
you to abort a file search that is in progress: useful if you 
have already found the file you want to download.
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4. Browse through or get info on a server with the selected file.

Clicking the Files button in the Items Found window will 
bring up another window that looks like this:

The browsing window

This window is the browsing window, which can be accessed 
by selecting Browse Server under the Server menu.  The 
browsing window behaves much like a list view in the 
Hotline client: double click to open folders, and use the Back 
button to go back one level.  To see the path to the current 
folder, click on the pop-up menu at the top of the browsing 
window. The Connect button tells HotFind to connect you 
to the Hotline server that is being browsed through the 
selected client.  You can also click the Download button to 
have Pitbull (available at http://www.tracker-
tracker.com/pitbull) automatically connect to the server and 
download the selected file.  If you double click on a file, the 
Download button will be invoked.

Occasionally, some servers will have tons of files in each 
listing.  To make it easier to find which file you want, you 
can sort the file list in the browsing window by clicking on 
the column headers.  Additionally, if you have already found 
the file you want, and do not wish to wait for the other files 
to be listed, you can press Cmd-. (period), and HotFind will 
stop listing the files.
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5. Connect to the server containing the file, or download it 
automatically using Pitbull.

Connect to the server using the Connect button.  You can 
also press the Download button to have Pitbull 
(http://www.tracker-tracker.com/pitbull) automatically 
download the selected file.  If Pitbull is not installed, HotFind 
will present you with a dialog that allows you to go straight 
to the Pitbull website.
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Registration 1. Launch the register application, or go to the registration 
website.

If you want to send in an order for HotFind by mail, select 
Launch Register Application from the Help menu.  If you 
want to order online, select Register HotFind Online from 
the Help menu.

2. Send in the order form, or register online.

3. Wait for your registration code.

You will receive your registration code by e-mail, as soon as 
your payment has been processed and approved.

4. Enter your registration code into HotFind.

Select Personalize from the Help menu.  Enter your name 
and registration number exactly as you received them.  
Registering HotFind is only $10 U.S., and will unlock the full 
features of HotFind.  Without registering, only a few 
trackers will be loaded into the server list, and only 50 
servers will be displayed, maximum.  Additionally, the 
registration window will keep appearing at startup until you 
register HotFind.
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Contact
Information

If you would like to submit bug reports, comments, or 
suggestions for HotFind, contact either Ben Vandevelde or 
Simone Manganelli.

Creator/Programmer:
Ben Vandevelde (a.k.a. Macron)
e-mail: macron@tracker-tracker.com

Beta Tester/Tech Support/Manual Creator:
Simone Manganelli (a.k.a. simX DP4)
e-mail: sim7@tracker-tracker.com

©5/15/2000 Simone Manganelli and Ben Vandevelde
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